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The PCLinuxOS Magazine has, for quite some
time now, been running an ad urging
PCLinuxOS users to NOT use their phones
while they are behind the wheel. The data is
clear that doing so leads to distracted driving,
and as expected, leads to often catastrophic
outcomes.

Advancements in mobile technology have made
us more “connected” than any prior time in
history. Most of us are only a text or phone call
away from those who need to contact us. That is
the upside.

But the downside is the number of people –
behind the wheel of a vehicle, nonetheless – on
their cell phones. You’re behind some idjit at a
red stoplight. The light turns green. And we sit
there until the light turns yellow again, all
because the idjit at the “front of the line”
thought it was more important to text or scroll
facebook or watch a video than it was to keep
their attention on the task of driving.

What’s even more mind-numbing is which
group of drivers I see that are guilty of this
offense. You might think it’s the younger
drivers, and you’d be wrong. Nope. It’s the
OLDER DRIVERS. These are the ones who
initially got their driver’s license before the
explosion of mobile technology. These older
drivers, you’d think, should know better.

There are enough potential distractions while
driving a vehicle that we really don’t need to
add in the additional distraction of texting,
Facebook, videos, and other online content.
Pedestrians, bicyclists, road conditions, traffic

patterns, construction zones, turning vehicles,
the surrounding vehicles, changing the radio
station, other passengers in the vehicle, and
animals all offer enough potential distractions
that we really don’t need to add in other
distractions.

Sending that text message can wait. Scrolling
Facebook can wait. Sending that reply to Twitter
can wait. Watching that video can wait. Sending
that email can wait. Your life or someone else’s
life makes it worth waiting to perform those
tasks. In many instances, lives hang in the
balance.

A vehicle going down the road at 55 mph (88.5
kph) travels the length of an American football
field (100 yards, or 91.4 meters) in less than
four seconds. Now there are a gazillion
statistics about texting, and one of them is NOT
how long, on average, it takes to reply to/answer
a text. On average, most texts in the U.S. are
read within five seconds. The response to those
text messages, naturally, depend on the length of
time it takes the end user to compose a reply to
a text message. Longer replies require more
time to compose. But, let’s say, for example,
that it takes you five seconds to read the text
message, and another 20 seconds to reply. In
that 25 second time period, you would have
traveled over FIVE American football field
lengths – over 500 yards or over 450 meters.
That’s over a quarter of a mile, or just under a
half kilometer! A lot of things can happen or

From The Chief Editor's Desk
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change within that distance in that short period
of time.

At any given time, it’s estimated that 660,000
drivers are using their cell phones while driving.
In the U.S., one out of every four car accidents
are directly attributable to texting while driving.
Those are ALARMING numbers!

Where I live, in Missouri, the lawmakers JUST
THIS YEAR made using your cell phone while
operating a motor vehicle illegal. It’s a mystery
why it took so long. Police can’t pull someone
over just for using a cell phone while operating
a motor vehicle. BUT, if the violator commits
another traffic offense and it’s discovered that
the violator was also using their cell phone at
the time of the offense, the offense of using their
cell phone while operating a motor vehicle can
be added on to the list of offenses.

In many other jurisdictions around the world, it
is already illegal to use your cell phone while
behind the wheel of a vehicle. It only makes
sense. Everyone is in agreement that operating a
motor vehicle while intoxicated is a bad idea.
Bad things happen. Using your cell phone while
operating a motor vehicle is as bad as, if not
worse (depending on the study you cite), than
driving while intoxicated.

So, please don’t be like all these idjits out there,
on their phones while operating a motor vehicle.
Put your phone down, and “arrive alive.” Your
life and the lives of those around you depend on
it. Most of all, we don’t want to lose any
PCLinuxOS users because they were on their

phones while operating a motor vehicle. We’d
also hate to see any PCLinuxOS users cause the
demise of innocent bystanders because they
were on their phones while operating a motor
vehicle.

********************

I shot this month’s abstract cover image while in
the waiting room of my son’s speech therapist,
while he was in one of his weekly sessions. My
daughter would always try to see how tall of a
tower she could build with these building
blocks. The image is looking down the center of
one of those towers she would build.

********************

Until next month, I bid you peace, happiness,
serenity, prosperity, and continued good health!

1. All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2. The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3. The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation. All trademarks are the property of their respective
owners.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.

Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.

Disclaimer

Like us on Facebook!

PCLinuxOS Magazine

PCLinuxOS Fan Club

From The Chief Editor's Desk
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https://www.facebook.com/groups/2210485167/


PCLinuxOS Magazine Page 5

by Paul Arnote (parnote)

A “new genie” has escaped the bottle. A new prince occupies the castle.
Elvis has left the building. The barn door has been bolted after the cows
and horses have left.

No matter how you frame it, talks about “regulating” (read that legislation)
the new, emerging and proliferating artificial intelligence (AI) technology
might just be too little, too late.

I’ll talk mostly about efforts in the U.S. to “regulate” the explosion of AI
across the computing landscape, simply because this is where I am, and
where the information I’m exposed to is most focused. But, we’ll also talk
a bit about the E.U., since they offer the best head-to-head comparison
with U.S. efforts.

But first, we need to look at a bit of recent history.

A History Of Non-Action

“Social media” popped up, seemingly overnight, around a quarter century
ago. Some of those early sites are nothing more than a blip on the history
of the internet (think MySpace, followed by Google+ and many others).

Almost as fast, social media sites became the de facto “town hall” for the
internet. Just as you might expect, that came with both good and bad.
Although it allowed users from all around the globe to connect and share
ideas and common interests, it also provided a fertile breeding ground for
the tribal mentality that besieges and divides society to this day. Users
would gather with those who shared their views, excluding or running off
those who didn’t. So, the “town hall” became a town square, with each
corner hosting different groups of users, all with differing views. The tribal
mentality effectively eliminated any healthy discussion of those views
among “warring tribes,” and shut down the process of these groups with
differing views of ever finding common ground. Instead, they just sit/stand
and shout at one another, with neither side listening to the other.

AI Regulation: Too Little, Too Late?

http://www.pclosusers.com/services-signup.php
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Of course, signing up for and using these social media sites is free. But
little in this world is truly “free.” There’s always a price/cost, albeit often a
hidden one. In the case of social media sites, it’s the hidden cost. They sell
advertising space on their sites, all while vacuuming up every last morsel
of your personally identifiable private information to provide/sell to
advertisers, who then use that information to target you with advertising
tailored to your interests. Your personally identifiable private information
is the currency that fuels social media.

In the U.S., legislators and others who oversee regulations did NOTHING
to regulate either social media or the collection of your personally
identifiable private information. Their inaction was louder than the song of
crickets while camping in the remotest parts of nowhere.

Meanwhile, across the Atlantic, the E.U. had the cojones and foresight to
enact the General Data Protection Regulation, a.k.a. the GDPR. The law,
which went into effect five years ago on May 25, 2018, effectively put
control of personally identifiable private information back into the hands
of its owner, and put limits on data collection and how long that data could
be retained. Even though they dragged their feet on addressing the issue,
the eventual passage of the GDPR puts the E.U. lightyears ahead of any
type of the U.S., where data and privacy protections are pretty much non-
existent.

Oh, sure you have states that have tried to address data collection and
privacy concerns. One such state is California. But, for the most part, such
laws don’t carry the weight of federal laws, nor sufficient penalties to
make them effective, rendering them little more than lip-service and a
public spectacle. Mostly, it’s just political showmanship so those elected
officials can stay in office, collect votes for re-election, and so they can
say “look at what I’ve done for you!”

It’s one thing to pass laws. It's entirely another thing to enforce those laws.
Even fining corporations that make multiple billions of dollars every
month a few million dollars in “penalties” is merely chump change for the
offending corporations. Often, it’s cheaper for the corporations to pay the
fines than it is to institute changes that will ultimately and significantly
lower their monthly profits.

Plus, you have to decide who will enforce the laws. Will you create a new
enforcement entity, or (and as is the most likely case), will you strap an
already under-manned, under-budgeted existing entity with the task of
enforcing the new laws? It’s easy to figure out which path most states take
regarding enforcement. Taking the second path typically results in under-
enforcement of the data collection and privacy laws, with only the most
egregious violators prosecuted as an example to other violators or would-
be violators.

And then you have the companies affected by such laws helping to write
such laws, and pour a ton of money into lobbying against legislation that

The place where breaking news,
BitTorrent and copyright collide

AI Regulation: Too Little, Too Late?

http://torrentfreak.com/
http://pclinuxoshelp.com/index.php/Main_Page
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“goes against” their path to riches. Now, if you were going to help write a
law affecting your line of work, of course you’d want to make sure it’s as
advantageous to your profits and bottom line as possible. This is exactly
what happens in every single instance where those affected help write the
laws that regulate their behavior.

Now, The Emergence Of AI

Without a doubt, AI is having its moment in the spotlight. Stories about it
are in the “news” everywhere. I can hardly go a day without reading yet
another story about how much of an asset AI is going to be, or how it will
lead to a destruction of society, and everything in between. There seem to
be as many opinions about the impact of AI as there are people writing
articles about it. In the U.S., AI’s moment in the spotlight is way ahead of
any attempts to regulate it. I mean, data collection and privacy haven’t
even been addressed, and here is yet another new technology that demands
attention.

It’s not that legislators haven’t tried or are opposed to regulating AI. It’s
more like they are all revved up in their sand buggy, but all they are doing
is spinning their wheels in the sand.

Sure, Congress has held hearings. The White House has issued “policy
statements.” But little to nothing has been done to put up the “guardrails”
that so many are calling for. One of the things explored include
“mandatory” disclosure when information has been generated by AI. That
is a good idea, just so long as the information originates in the U.S.’s
jurisdiction, and the “rules” are followed. A quick drive down the highway
should show you how well people follow the rules. What happens when
that information is generated from one of the countries responsible for
abuses of technology, like North Korea, Russia, or the People’s Republic
of China? All three countries are “safe havens” for threat actors, and many
of those threat actors are state sponsored.

Three prominent experts with AI have testified before the Senate Judiciary
Committee’s Subcommittee on Privacy, Technology, and the Law (click on
the following links to read their testimony). One was Gary Marcus,
professor emeritus at New York University. He has been involved with AI,
helping to start AI companies. His testimony highlights the worries and
risks with AI, and the need for companies and governments to work
together to minimize risks while keeping AI accessible for all people.

Another was Christina Montgomery, Chief Privacy & Trust Officer for
IBM. Keep in mind that it was an earlier version of AI produced by IBM,
known as Watson, that won the TV game show Jeopardy!. She spoke at the
hearings to express how she, as IBM’s AI Ethics Board co-chair, sees the
necessary AI guardrails working.

Probably the most high profile person to give testimony at the hearing was
Sam Altman, CEO and co-founder of OpenAI. It is OpenAI that has
produced the latest version of AI that has the computing world all excited,
with ChatGPT and DALL-E 2. He discussed the lengths OpenAI goes to to
ensure that its AI products are safe and appropriately restrained.

Other tech leaders, including a group that includes Elon Musk and Steve
Wozniak, have called for a six month “pause” on further AI development
in an open letter, to give industry, regulators and legislators a chance to
catch up with constraints and guardrails for AI. The letter has nearly
30,000 signatories at the time of the writing of this article. Other tech

AI Regulation: Too Little, Too Late?
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leaders want to continue AI development, full steam ahead, and call
Musk’s (et al) concerns unfounded. Former Google CEO Eric Schmidt is
one tech leader who doesn’t support a six month A.I. pause ‘because it will
simply benefit China,’ according to an article on Fortune.

Meanwhile, the E.U. is considering far-reaching legislation on artificial
intelligence (AI), according to an article on the World Economic Forum
website. The fact that they are even considering legislation, which has
already been drafted, puts the E.U. years ahead of the U.S. This is
especially so when you factor in the protections already in place and
afforded by the GDPR.

On the day that Elon Musk et al called for a pause in the “dangerous race”
to develop ever more powerful AI, the UK government published its long
awaited “Pro-innovation approach to AI regulation” white paper,
according to an article on Lexology.

AI is the topic d’jour in most of the major countries with a reliance on
tech. India is proposing its own legislation, aside from calling for an
international approach to regulating AI. China is taking a look at a broad
approach that would affect any AI company that has the ability to reach
Chinese internet users.

Why Regulating AI Is So Difficult

THAT is the $25,000,000 question. As you can imagine, there isn’t any
singular answer.

With even CEOs of AI companies asking for regulation, it isn’t that clear
cut. The problem is how to regulate AI without stifling development,
deployment or access.

Congress (I use that term collectively, for the House and the Senate) is
largely ignorant about what AI is, what its use is, how it works, etc. Only
ONE member of Congress has a master’s degree in artificial intelligence,
and that is Representative Jay Obernolte of California. To address this
knowledge gap, House Speaker Kevin McCarthy has arranged a “class”
for any/all members of Congress, regardless of their party affiliation,
according to an article from Fox News. Lawmakers who attend will have
the chance to hear from two AI experts from MIT.

But this is also the same group that really has no idea how the internet
works, how email works, or any other modern tech for that matter. These
lawmakers are dinosaurs when it comes to tech issues. So, how can they
effectively write legislation to guard against abuses of tech? This is
probably the number one reason that a transparent partnership between
lawmakers and the tech industry is (or should be) the ONLY path forward.

According to an article on Fox News, in 2022, the House Energy and
Commerce Committee passed the American Data Privacy and Protection
Act (ADPPA), a bill that’s aimed at boosting data privacy rights but would
also play a big role in regulating emerging AI systems. The ADPPA won
almost unanimous support from both parties last year and continues to be
supported by companies that are eager to build trust in their AI products,
and they believe that a federal regulatory structure will help them get
there. BSA/Software Alliance represents dozens of companies, including
Microsoft, Okta, Salesforce and others, that build software and AI tools
that companies use to run their businesses. BSA is working closely with
the committee to get a version of that bill passed this year that it hopes can
be approved in a full House vote.

AI Regulation: Too Little, Too Late?
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Then you have the concerns of how much any potential lobbyists and
special interest groups might have influenced any possible legislation. The
lobbyists and special interest groups will work tirelessly to water down
any potential penalties, as well as any meaningful constraints. That. Is.
Their. Jobs. The end result is typically legislation and regulations that
favor the corporations, and the people it’s intended to protect be damned.
The promise of corporate/industry campaign donations for re-election
coffers goes a long way towards getting the attention of a lawmaker who is
ultimately concerned about re-election and lengthening his or her stay in
office.

Another concern about AI is eliminating bias in its use and responses. That
might be a bit difficult, since AI is likely to possess the same biases as
those that program it. In other areas, AI has been caught making stuff up
(lying) and it’s a bit difficult to discern what is factual and what is fiction.

There is also the fear that AI could be harnessed to perform character
assassinations on individuals. Without full disclosure, it would be almost
impossible to discern whether something actually happened or not. In
today’s societal and political divisions, and with a major presidential
election just around the corner, AI saying something happened or someone
said something when neither actually happened is a HUGE concern.
Without proper and adequate safeguards, AI could contribute to even
greater divisions at a time when it’s already extremely difficult to separate
information from disinformation.

Summary

We’ve already talked about how frighteningly real images created by
DALL-E appear, and how easy it is to wipe out the EXIF info of an image
to help blur that line between reality and fantasy in last month’s issue of
The PCLinuxOS Magazine.

Because of their inaction on other tech trends, I personally don’t hold out
much hope for U.S. lawmakers to “get it right.” Gridlock and inaction
seem to be their ultimate goal, at least judging by their actions (or

inactions). Only time will tell. We should all hope that they act before AI is
used catastrophically or causes irreparable harm.

The whole issue about regulating AI is evolving at a lightning pace. We’re
all going to have to stay tuned and pay close attention. I suspect I’ll be
writing more about this in the very near future.

All images by geralt, on Pixabay.

Defending Your Rights

In The Digital World

AI Regulation: Too Little, Too Late?

https://www.eff.org/
https://pixabay.com/users/geralt-9301/
https://pixabay.com/
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Serves 6

INGREDIENTS:
9 oz. (255 g) Nacho Cheese Doritos
1 egg, beaten
2 pounds (910 g) chicken tenders, cut into thin
strips.
1 teaspoon (5 ml) garlic powder
1/2 teaspoon (2.5 ml) salt
fresh black pepper to taste
For dipping: Ranch, sour cream, ketchup, BBQ
sauce or your favorite sauce

DIRECTIONS:

Place Doritos or tortilla chips in a bag and crush
them with a rolling pin into fine pieces. The
smaller the chip pieces, the better they will stick
to the chicken.

Cut the chicken into thin strips and season with
garlic powder, salt and pepper. Put the beaten
egg into a bowl.

Dip each chicken strip into the beaten egg then
into the crushed Doritos. Gently press the
chicken into the crushed tortilla chips, then use
the spoon to pour chips over the top of the
chicken. Gently press chips into chicken. This
method allows the chips to stay dry. If they’re
wet, they stick less to the chicken.

Spray air fryer basket or racks with oil spray.
Gently lay chicken pieces in the basket or on the
racks. Spray oil spray on top of coated chicken.

Air Fry at 380F (195C) for 15 minutes. Gently
turn the chicken pieces and spray the tops with
oil spray (don't turn the chicken too rough or
else the Doritos pieces will fall off).

Air Fry for an additional 3-5 minutes, or until
the crust is crispy golden brown and chicken is
cooked through. Serve with your favorite dip or
sauce!

TIPS:

You can bake these in your oven at 400F
(204.4C) for 15-20 minutes, turning over once
halfway through. Test to make sure that the
chicken is no longer pink inside.

Substitute Nacho Cheese Doritos with any other
flavored Doritos such as Salsa Verde, Spicy
Sweet Chili or Cool Ranch

NUTRITION:

Calories: 392 Carbs: 28g Fiber: 2g
Sodium: 559mg Protein: 36g

PCLinuxOS Recipe Corner

Air Fryer Doritos Chicken Tenders

http://www.commandlinefu.com
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by expresso

According to Synaptic, NovelWriter is “a
markdown-like editor for novels”. Well, what
does this mean?

As the name implies, it’s a program intended for
writing novels. It has several features to help
with that, including an adaption to the
markdown syntax to help with getting an
overview of the novel. On my computer (a
reasonably old one), this application launches
instantly and is very responsive.

When we open NovelWriter we are immediately
greeted by an “open project” window. It lists the
projects we’re busy with, which can be opened
by double-clicking. There are several other
options at the bottom to create a new project,
remove a project, and to change the current
path.

I chose to create a new project. It asks me
several questions about the project and finally
asks me whether I would like to have it fill the
project. I chose the option which results in an
example project (right).

On the right hand side is the preview of the
novel. This pane can be turned on and off as
desired by clicking the “x” or selecting
Document > Close Document View. This is

what results from compiling the project, but
here it’s just a preview. The middle column is
the editor.

Compiling a resulting project is quite easy: just
select “Build project” from the tools menu and a
window pops up which allows you to tweak the
build details. Once you’re satisfied you can
click have it saved in various formats. I would
have loved to see some more export formats, but
one can always hope.

On the left side is the project tree. Each entry in
there references a separate document. Below the
project tree is some information on the entry
selected. It contains some handy information,
such as word count and whether an item is
“active” (to be included in the compilation
process). There’s also some information
communicated by the colored squares to the
rightmost side of each entry. The colors can be
configured and their description changed, right
from within the GUI.

This is what we now see.

NovelWriter: Help Writing Your Next Bestseller
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There’s also a distraction free mode, which
makes the application go full screen and drops
you into an editor, with only a few icons and
some additional information (View > Focus
Mode). This is handy for writers who wish to
work without clutter on their screen. In this
mode only things which are strictly necessary to
be there are present.

Finally, if you want a bird's eye view of your
project, you can take a look at the outline view.
While – at the moment – it’s not possible to
change what you see, it does provide loads of
quick information about each chapter and scene
of a novel.

It is well organized and provides a good overview of
your story.

Finally, there’s something which makes
NovelWriter quite interesting: on top of it
supporting a form of markdown (which is
explained in its excellent documentation), it also
has a tag system (of which, admittedly, the
documentation could use some improvement).

In the project tree in the first image of this
article, the user can see that there are several
different types of root folders. These indicate
the tag used to reference their content. However,
if a user wants to be able to reference a note
from his story, the note needs to have a tag
assigned to it. The tagging system is literally
part of the format of NovelWriter.

An example from the example project: there’s a
character called “Jane” and, as you can see,
there’s a “@char” entry on her, multiple entries
of the same type can be referenced by separating
them with commas. Then, below the
“characters” root folder, there’s an entry on
Jane. Somewhere in this document there’s a
“@tag: Jane”. Tags can be right clicked and
followed through the project. This is useful if
you want to reference a note on a character
while being busy with a scene or chapter.

There’s also a menu which lets you include
various symbols which are not easily typed. In
that same menu, there’s an option to convert
single and double quotes. It’s details like this
which makes this program so nice to work with.

By default NovelWriter installs are configured
with a pretty bright color scheme, however there
is a good selection from bright as well as dark
skins and color schemes for syntax highlighting
readily built in.

There are some drawbacks of this program.
While it is definitely a mature project, with an
active maintainer, it misses some features which
would make life easier, most notably the ability

to compile epub and pdf documents, which
would be nice. Also, at times, especially when
working with the project tree, it feels a bit
clunky.

Export formats

The file format which NovelWriter uses to store
its projects has both advantages and drawbacks.
A NovelWriter project is basically a directory
structure eventually containing dozens of
individual files. However, each of those is in a
human readable format. This allows the writer
to combine NovelWriter with a revision control
system, such as git. Another advantage is
protection against corruption. A disadvantage is
that there are potentially a lot of small files to be
dealt with.

Overall this is an excellent program for
(aspiring) authors. The program appears
instantly on your screen and is very well
behaved. It has good configuration options,
especially when related to the project at hand. It
has a tendency to grow on you, and once you’re
familiar with it, you can be very productive with
it. All that being said, its user interface can seem
clunky at places.

NovelWriter: Help Writing Your Next Bestseller
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It can be found in Synaptic as “novelwriter”,
and its website (which is quite nice) is
https://novelwriter.io/, where you can learn
more.

Screenshot ShowcaseScreenshot Showcase

Posted by jogurmen, May 7, 2023, running KDE.
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by Meemaw

As I’m looking on YouTube for interesting
things to do with Inkscape, I found one from
IronEchoDesign on how to make a Celtic Knot.
It’s fairly easy and very fun!

In this tutorial, we’re going to use the Path
Effect called Knot.

I’m going to use some rectangles the first time
to illustrate what this effect does. If I draw three
rectangles and overlap them I get something like
this:

Make sure you have them all selected, and
choose Path > Object to path. Showing the
settings, I did these with a 12 px stroke, and no
fill. I also want to choose Square Cap in the
stroke settings. We’ll get to that soon. Also
make sure you group your objects, because the
path effect only works on one object. Now

choose Path > Path Effects. You’ll get a
window like this:

Add a path effect by clicking on the plus sign at
bottom left. You’ll get another window:

Since I’ve already done this, the Knot effect
was already chosen. However, you can find it
by searching, but the effects are listed in
alphabetical order, so you should find it easily.
As soon as you click Knot, the effect will be
applied (top, right).

Notice it now looks like they are interlinked.
From the path effects settings window you can
choose the gap between the lines to make it a
smaller gap or a larger gap. The default is set at
3 and “In units of stroke width” is checked. This
means that if you set your stroke in pixels, your
gap will be pixels, and if your stroke is
millimeters, your gap will be as well. Above the
gap is a setting called the Switcher. This is a
tool for making sure your strokes are truly
interlinked, so if you are looking at which
strokes go over or under the strokes they cross,
and want to switch them, you can do that.
Change your tool to Edit Paths by Nodes and
you will see a handle with a circle around it.
That’s the switcher. Click on it once, and it will
reverse the lines so the other looks like it’s on
top. Click it again and it will remove the gaps
entirely. As shown on the next page, the first on
the left is what it looks like when you first see it.

Inkscape Tutorial: Create A Celtic Knot

https://www.youtube.com/@IronEchoDesign
https://www.youtube.com/watch?v=08zpOs-yoTw&ab_channel=IronEchoDesign
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The middle image is after it’s clicked once and
the right image is after a second click.

Want to change another intersection? Drag the
switcher to the one you want. Be careful that
you don’t click outside your object, because
sometimes when you click back, your switcher
is gone. You can get it back if you click on your
stroke while the path effects settings window is
open.

Now that we have most of what we need, let’s
make an actual celtic knot. We’ll use circles
instead of rectangles this time, so draw a circle.
Instead of duplicating it, use Copy & Paste to
make another circle the same size (Iron Echo
Design’s tutorial mentioned that duplicating
sometimes causes problems). Make sure you
choose Path > Object to path.

Select them both and use your Align &
Distribute tool to align the bottoms of the
circles, then choose Path > Intersection. It
should look like this:

You can make this a bit longer if you wish.
Click on the arrows again so you get your
rotation arrows, then hold down (CTRL) and
drag the object until it is rotated about 45
degrees. Holding the (CTRL) down will allow it
to move about 15 degrees and then stop until
you drag more. Now copy & paste to create
another object just like the one you have.
Reverse the direction of the new one (flip
horizontally) and center them together. Also,
create another circle (top, right).

Make sure they are all selected, then center
them horizontally and vertically. Now group
them, then choose Path > Path Effects and
choose Knot (right).

You should check first to see that your gaps
alternate (like I discussed above). Wow, that still
doesn’t look as good as I had hoped! Good thing

we set our stroke settings for square cap, and I’ll
show you what to do to fix this. First, click on
Path > Stroke to path, then change your tool to
Edit path by nodes. You’ll now see four
handles near each of the ends of the square
paths. You can drag the nodes until the gap
looks the way it should (next page, top left).

You can use another trick to help. Since you
added Stroke to path, you can add a stroke to

Inkscape Tutorial: Create A Celtic Knot
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the outside of your line temporarily, and that
will help you line up your gaps at an equal
distance. You can always remove it later if you
wish. I put a 3px stroke on this to help me edit
the gaps, but took it off afterwards (center, top).

While I’ve gotten a little shaky in my old age, I
have managed to fix the gaps. I know you can
do it, too. Have fun!
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by David Pardue (kalwisti)

If your digital music collection is similar to mine, the music files are
haphazardly tagged with various degrees of completeness. Some files may
lack informative names and cover art; others may have misspelled track
titles or incorrect genres. To better organize your collection, specialized
audio tag editors allow you to add and/or edit metadata. Metadata lets
information about the audio file -- such as Title, Artist, Composer, Album,
Genre, Year -- be stored in the audio file itself. (These core tags are
popularly known as ID3 tags).

Puddletag is a simple yet powerful, Qt-based music tag editor that uses
Python 3 and PyQt5 (for the GUI). Under the hood, the application uses
Mutagen, a Python module which handles audio metadata. Puddletag is an
alternative to EasyTag, the oldest and perhaps most commonly used tag
editor.

Puddletag is a mature project with a fourteen-year track record. It was first
released in July 2008. The original developer, known by the Internet
moniker concentricpuddle, is now assisted by a group of developers which
includes Sandro Tosi (a computer scientist from Italy) and Corubba
(Germany). The program has been translated into French, German, Dutch,
Spanish, Portuguese (Brazilian), Czech, Swedish and Russian. The version
in the official PCLinuxOS repository is 1.2.0 (released in November
2016).

Puddletag is a Linux-native application that has a user interface similar to
the popular Windows freeware program Mp3tag. Its most distinctive
feature is a spreadsheet-like layout for tag editing. This design allows you
to copy and paste one (or more) fields from one file across many, select all
tags in a tag column, edit one and then have it cascade through the
selection. The layout also makes it easier to spot problems or untagged
elements.

The usual tag editor features, such as extracting tag information from
filenames, renaming files based on their tags by using patterns and basic
tag editing, are supported.

Then there are Functions, which can do things like replace text and/or trim
it, do case conversions, etc. Actions help automate repetitive tasks.
Integrated web searching via MusicBrainz, Discogs.com, FreeDB and
Amazon is also possible.

Supported formats include the following: ID3v1, ID3v2 (.mp3), MP4
(.mp4, .m4a), VorbisComments (.ogg, .flac), Musepack (.mpc), Monkey’s
Audio (.ape) and WavPack (.wv).

This screenshot shows Puddletag's basic layout, with the contents of my
/Music/Art Blakey folder open, as well as the Tag Panel (in the upper-left
quadrant) for the highlighted track:

Repo Review: Puddletag
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If you find the Tag Panel distracting, you can dismiss it by clicking on its
Close button, or by going to the Windows menu and
unchecking/deselecting the Tag Panel option.

Puddletag can use a "manual" method for adding ID3 tags to your music
files, or a "semi-automated" fashion. That flexibility is welcome because
you will not always succeed in retrieving metadata for your albums from
Puddletag's integrated Tag Sources.

Retrieving Metadata from Integrated Tag Sources

Puddletag streamlines metadata searches by serving as a gateway to
several online music databases. This will save you time by populating
empty tags and retrieving cover art for your music collection. You choose
your desired database via the Tag Sources window. In version 1.2.0, these
Tag Sources are included: MusicBrainz, Discogs.com, FreeDB and
Amazon. (The program's current release -- ver. 2.2.0 -- includes the
aforementioned databases plus AllMusic.com). Based on my testing of the
app, MusicBrainz was the most dependable/reliable Tag Source.

I will summarize these sources, since not all readers may be familiar with
them.

FreeDB: The granddaddy of online music databases, it played a key role
in the history of music digitization. Its name was synonymous with the
ability to rip an audio CD. FreeDB was a community-generated database
of strictly CD music metadata. It was established as a free alternative to
the proprietary CDDB ['Compact Disc Database'] owned by Gracenote,
Inc.

FreeDB was shut down in March 2020. However, the database was
extracted and found a new home/host at gnudb.gnudb.org. The database
currently contains 4.7 million entries.

Unfortunately, FreeDB search capability does not work in our older
PCLinuxOS version because its setting cannot be configured via the user

preferences. It can only be changed by altering the source code. So this
value (from 2016) is querying the defunct FreeDB address, rather than the
current one.

MusicBrainz: MusicBrainz has almost all the FreeDB database imported,
plus it has added more entries of its own. The resulting data set is typically
of higher quality than FreeDB. MusicBrainz covers all kinds of recordings
/ releases with unique IDs; therefore, you will find separate entries for
vinyl LPs as well as country-specific releases (e.g., US, Japan, Germany,
etc.). MusicBrainz metadata often includes album cover art.

(As an aside, MusicBrainz has its own file tagger software -- called Picard
-- that can access the MusicBrainz database to locate metadata to embed
into your music files. Picard is available in the official PCLinuxOS
repository).

Discogs: Discogs is a database with information about audio recordings –
including commercial releases, promotional releases and bootlegs.
Although its original goal was to be the most comprehensive database of
electronic music, Discogs now includes releases in all genres. Discogs also
has a Marketplace feature to facilitate sales between music sellers and
buyers. (It is similar to eBay in that Discogs does not sell anything
directly; interested purchasers buy from individual sellers via the
platform).

Amazon: Accessing Amazon metadata is not a realistic option, in my
opinion. You must create an Amazon Associates account with registration
for the Product Advertising API. In addition, your Associates ID must have
periodic sales to keep the key active. Otherwise, Amazon will close the
account.

It is a fairly straightforward procedure to retrieve metadata via
MusicBrainz. First, open the Tag Sources window. Go to the Windows
menu, and select/tick the Tag Sources option. Second, choose MusicBrainz
as the Source database to search. Third, select/highlight a row of your

Repo Review: Puddletag
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music file. Finally, click on the Search button. In the example below, I am
searching for metadata on singer Cesaria Evora's album, Cabo Verde:

Now, select the correct album metadata from your retrieval list.

Tag Sources are album-based rather than track-based. However, you can
choose individual tracks from an album). Click on the Write button.
(Puddletag will not write any metadata retrieved from the Tag Source until
you instruct it to). Puddletag can retrieve cover art, if it is present in the
metadata. Click on the wrench icon to the right of the Source box (top,
right).

Next, select / tick the Retrieve Cover option and then click the OK button.

Adding Cover Art Manually

If your Tag Source lacks cover art for some reason, it is simple to add it
manually.

First, do a web search for the album artwork and save the image(s) to your
PC. This article suggests some good sites to explore.

Now, select/highlight a row of your music file. Type Ctrl+E to access the
Extended Tags dialog. A pop-up window will appear. In the right pane of
that window, click on the green "+" [plus] sign (next page, top left).

Repo Review: Puddletag

https://www.lifewire.com/best-album-art-websites-2438773
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Navigate to your downloaded image file, select it and click on the Open
button. Make a selection from the Type drop-down menu – you probably
want to choose Cover (Front) – and click the OK button.

Click on the Save icon [a floppy diskette] in the main toolbar, or type
Ctrl+S, to finalize this change.

A Note on Puddletag's Flatpak

The most recent version of Puddletag, 2.2.0 (released in July 2022), is
available on Flathub. Although I was able to successfully install the
Flatpak on my PCLinuxOS system, I was disappointed that none of the
online music databases/Tag Sources worked. When I tried to search, the
app would throw error messages. I was unable to troubleshoot this glitch.
Since metadata searching is an important feature to me, I uninstalled the
Flatpak and went back to using ver. 1.2.0 from our official repository.
(Another factor in my decision to delete the Flatpak was its huge size; after
installation, it occupied nearly 5GiB of disk space).

Additional Resources

Current development activity on Puddletag has shifted over to GitHub.
Nevertheless, there are several mini-tutorials (with screenshots) available
on its previous website.

If you prefer video tutorials, the most helpful one I found was created by
user ProfessorKaos64. Although the version he uses is older – it is likely
ver. 1.0.1 or 1.0.2 – the features that he demonstrates have not changed
since 2012 - 2013.

Summary

If you are looking for an alternative to EasyTag that is Qt-based, Puddletag
is an attractive option. Puddletag's distinctive spreadsheet-style GUI is a
bit unfamiliar if you are accustomed to EasyTag's interface. However, it
works well out of the box and if you only need to do the basics – such as
tagging and adding cover art to your music files – you will soon feel at
home with the program. If you are willing to delve deeper into its
documentation, Puddletag's powerful bulk-editing capabilities become
more apparent. I saw a comment from a Reddit user that Puddletag was
able to easily handle 50,000 - 60,000 tracks in bulk tagging operations.

Repo Review: Puddletag
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by Paul Arnote (parnote)

Your email address may actually be hurting
your chances for landing that new job,
according to an article on Lifehacker. Believe it
or not (or like it or not), gmail.com email
addresses are generally viewed as “neutral.”
Addresses from aol.com or yahoo.com may
elicit concerns about your age. And email
addresses like “ladysman@someemail.com” or
“satansoffspring@anotheremail.com” or
“darthvaderfan@sith.net” may be torpedoing
your job chances before you ever get out of port,
so to speak.

The U.S., Europe and Ukraine are reportedly
targets in this malware threat involving Cisco
routers, according to an article on
TechRepublic. State–sponsored Russian threat
actor APT28 targets certain Cisco routers with
an old vulnerability. I’ll wait patiently to see a
show of hands of everyone who has ever/never

applied patches to their router. [chirp-chirp]
[chirp-chirp] [chirp-chirp] sing the crickets.
Yeah … me neither. Routers (and other
hardware) can be “borked” or “bricked” too
easily while applying patches, and cost too
much to replace (if they do end up
borked/bricked). Thus, the vast majority of users
never do apply patches to hardware, despite the
presence of a valid and verified threat vector.
Fortunately (unfortunately?) these particular
Cisco routers (they never say in the article
exactly which routers are affected) appear to be
“commercial” routers. But then again, you can
never know for sure which consumer-level
Cisco routers use a command or SNMP protocol
(the attack vector) that has been (or may have
been) “inherited” from the commercial side of
their business.

Researchers have found that Google’s 2FA
app update lacks end-to-end encryption,
according to an article from TechRepublic. Data
synced between devices with the new Google
Authenticator app update could be viewed by
third parties. Google says the app works as
planned, but added that they plan to offer E2EE
as an option in the future. Yeah. It’ll probably be

like that Linux version of Picasa that Google
never released, or the Linux version of Google
Drive that they never released. In other words,
don’t hold your breath.

According to an article on Lifehacker, there are
at least FIVE things scammers are hoping
you Google or otherwise search for. Searching
for one of the phrases listed in the article can
draw you into a trap.

You’ve seen their advertisements … well …
EVERYWHERE. And, I include this here
simply because of the vast number of MLUs
(Mature Linux Users) in the PCLinuxOS family.
You may know them as the “We Buy Ugly
Houses” people. HomeVestors of America, the
self-proclaimed “largest homebuyer in the
U.S.,” trains its nearly 1,150 franchisees to
zero in on homeowners’ desperation,
according to an exposé on the ProPublica
website. They tend to zero in on older
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homeowners in the twilight years of life.
Knowledge is power, and this article should
help “arm yourself” to fend off their predatory
business practices.

The results are in! Google, which USED to use
the old motto “do no evil,” seems to have
changed their motto to “use it or lose it.”
According to an article on Lifehacker, Google
has updated their “inactivity policy” for all
Google accounts. If an account has not been
used or logged into for at least two years,
Google may delete the accounts and its data.
That includes Google Workspace (Gmail, Docs,
Drive, Meet, Calendar) and Google Photos
content. Google’s reasoning for the decision is
security-based. According to the company, an
account that hasn’t been accessed in more than
two years is likely compromised, because those
accounts often use leaked passwords, lack 2FA,
or have less security settings. While that idea
may have some merit (Google says abandoned
accounts are ten times less likely to have 2FA
set up), it still seems extreme. Welcome to the
World according to Google! It sounds to me as
if they are trying to make excuses for their
horrible track record when it comes to security.

Japan will try to beam solar power from
space by 2025, according to an article from
Engadget. The country made a breakthrough in
space-based solar energy back in 2015.

Image: NASA artist concept.

NASA is seeking industry proposals for a
next-generation LTV (Lunar Terrain Vehicle)
that will allow astronauts to go farther and
conduct more science than ever before as they
explore the south polar region of the Moon
during Artemis missions, according to an article
on SciTechDaily.

Google has begun rolling out a generative AI
function to its standard Google search
program for selected users in the United States,
according to an article on Interesting
Engineering, and widely reported on in multiple
media outlets.

For Computex 2023, Intel announced new
details about its new AI-focused VPU silicon
that will debut in the company's new Meteor
Lake chips, according to an article on Tom’s
Hardware. The company also outlined its efforts
to enable the AI ecosystem for its upcoming

Meteor Lake chips. Intel plans to release the
Meteor Lake processors, its first to use a
blended chiplet-based design that leverages both
Intel and TSMC tech in one package, by the end
of the year. The chips will land in laptops first,
focusing on power efficiency and performance
in local AI workloads, but different versions of
the design will also come to desktop PCs.

According to scientists from the University of
Washington, there are certain colors that repel
mosquitoes and others that attract them, says
an article from Tom’s Guide. Their study,
published in Nature Communications, revealed
that the mosquito’s sense of smell (olfaction),
influences how it responds to visual cues/colors.
However, this color preference only occurs in
the presence of carbon dioxide (CO2), which we
exhale when we breathe. And while mosquitoes
respond to our breath, sweat, and body
temperature — eliminating the colors that
attract them in the first place could help keep
them at bay. So, if you want to banish these
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pesky pests, you could try one of these colors to
repel mosquitoes in your home or yard.

Adding to the security nightmare they have
already have unleashed, a recent move by
Google to populate the Internet with eight
new top-level domains is prompting concerns
that two of the additions – .zip and .mov – could
be a boon to online scammers who trick people
into clicking on malicious links, according to an
article on Ars Technica.

When your internet isn't performing up to
standard, your first thought probably won't be to
blame your internet provider. After all, there
are many reasons why your internet could be
moving slowly, according to an article on CNet.
But, then again, your internet service provider
may be throttling your internet speeds.

Data storage on hard drives may soon
become a thing of the past, according to an
expert Shawn Rosemarin, who also owns a
company selling solid-storage solutions, says an
article on Interesting Engineering. According to
Rosemarin, we could see the last hard drive
being sold in just about five years from now, PC
Gamer reported.

Always breaking the mold on what’s deemed
impossible, scientists have discovered a way
to create electricity out of thin air, according
to an article from Giant Freakin Robot. While
many regions are preparing themselves for the
arrival of the unpleasantness of humidity that
will run rampant over the summer, it’s in that
nasty, watery air that the electricity can be
pulled from. But, don’t be too quick to literally
“cut the wire” that brings electricity into your
home.

After a three-year hiatus, scientists in the U.S.
have just turned on detectors capable of
measuring gravitational waves — tiny ripples
in space itself that travel through the universe,
according to an article on Inverse. Unlike light
waves, gravitational waves are nearly
unimpeded by the galaxies, stars, gas, and dust

that fill the universe. This means that by
measuring gravitational waves, astrophysicists
can peek directly into the heart of some of these
most spectacular phenomena in the universe.

The legendary Japanese astronomer Koichi
Itagaki made a dazzling discovery recently,
capturing observations of a visible supernova
so close to Earth that astronomers have been
able to spot it with amateur telescope setups,
according to an article on BGR. The supernova
was found in the galaxy M101 and has been
designated SN 2023ixf. This particular
supernova is so intriguing because it is so close
to Earth, allowing an assortment of astronomers
and skywatchers to get a possible view of it
without needing expensive equipment to pull it
off.

Microsoft has uncovered stealthy and
targeted malicious activity focused on post-
compromise credential access and network
system discovery aimed at critical
infrastructure organizations in the United
States, according to a Microsoft security blog
post. The attack is carried out by Volt Typhoon,
a state-sponsored actor based in China that
typically focuses on espionage and information
gathering. Microsoft assesses with moderate
confidence that this Volt Typhoon campaign is
pursuing development of capabilities that could
disrupt critical communications infrastructure
between the United States and Asia region
during future crises.

A magazine just isn't a magazine
without articles to fill the pages.

If you have article ideas, or if you
would like to contribute articles to the

PCLinuxOS Magazine,
send an email to:

pclinuxos.mag@gmail.com

We are interested in general articles
about Linux, and (of course), articles

specific to PCLinuxOS.
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https://bgr.com/science/astronomers-spotted-a-supernova-thats-so-close-its-visible-through-amateur-telescopes/
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compiled by Meemaw

Dog Walks 166 Miles Across Sea Ice

Mandy and her children went visiting another
town last March. While they were gone, two of
Mandy’s dogs and her uncle’s dog went missing.
The uncle’s dog regularly goes wandering and
always comes back. One of Mandy’s dogs,
named Startlight, returned after three weeks, but
the second dog, named Nanuq, didn’t come
back with Starlight. Nanuq is an Australian
Shepherd, and the American Kennel Club
(AKC) describes the Australian Shepherd breed
as smart, work-oriented, and exuberant, adding
they are “lean, tough” ranching dogs.

The family kept searching until Mandy’s father

told her he heard that someone had seen Nanuq
in a town 166 miles away. Checking her
Facebook page, and saw pictures of a dog that
someone had posted. She realized it was Nanuq,
and they went and got him.

Thankfully, a family had seen him and cared for
him until Mandy’s family could go get him.
They told Mandy that Nanuq had a swollen leg
from apparently being bitten during his travels,
but responded well to medicine. “If dogs could
talk, both of them would have one heck of a
story,” Mandy told reporters.

Woman Wins Lottery After Paying For
Daughter’s Cancer Treatments

Geraldine was on her way home, and stopped at
a local store to buy a lottery ticket. She liked the
ones with crossword games. As soon as she
finished the crossword, it was apparent that she
had won the $2 million jackpot! Her winning
came the day after another wonderful day.

Her daughter said, “The day before my mom
bought this ticket, I rang the bell and walked out
of the hospital after completing my last
treatment for breast cancer. My mom had taken
out her life savings to take care of me when I
was sick. I’m just so happy for her!”

Her daughter and granddaughter went with her
to receive the winnings, and took a publicity

photo (above), along with the Lottery’s Chief of
Staff.

Looking at her options, she decided to take the
lump sum payment, minus taxes - around $1.6
million.

Pizza Delivery Driver Saves Five Children

Nicholas was delivering pizza when he saw a
house on fire. Turning around and driving to the
house, he yelled that the house was on fire, but
he didn’t hear anything. He then entered the
house himself to look for anyone who might be
in there. He found four children and got them
out safely, and was told that there was a fifth
child inside.

Good Words, Good Deeds, Good News

https://www.breitbart.com/local/2023/04/13/photo-missing-dog-treks-166-miles-across-sea-ice-while-suffering-bite-wounds-one-heck-of-a-story/?utm_source=newsletter&utm_medium=email&utm_term=b_inspired&utm_campaign=20230415&utm_content=Final
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https://www.akc.org/dog-breeds/australian-shepherd/
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By then the house was filled with smoke and he
had to crawl on the second-story floor to find
her. They got out through a window on the
second floor, after he broke it out, cutting his
arm. The children are all safe, and Nicholas
received treatment for smoke inhalation, burns
and the cut on his arm.

The grateful family has set up a GoFundMe
page to help him with his medical bills, and he
has been awarded the Carnegie Medal for his
selflessness. The Carnegie Medal is given
throughout the U.S. and Canada to those who
enter extreme danger while saving or attempting
to save the lives of others. The Carnegie Medal
has been awarded to 10,355 individuals since
the start of the Pittsburgh-based Fund in 1904.

Student Stops School Bus When Driver
Passes Out

A Warren, Michigan school bus driver was on
her route when she started feeling dizzy. She

radioed in to her superiors and told them she
was stopping the bus, but before she could get
stopped, she passed out. Amazingly, one of the
students, 13 year-old Dillon, ran to the front of
the bus and applied the brake, steering the bus to
the side of the road, and instructing his fellow
students to call 9-1-1 for the driver.

City officials praised Dillon for his quick
thinking and calm in an emergency. The bus
driver went to the hospital where she underwent
testing to find the cause of her fainting.

The school Superintendent commented, “I don’t
know that it could have gone any better, and
when you have an anchor like Dylan taking care
of business on the bus, it really and truly was a
good day for us.”

Baby Survives With Birth Weight of 1.17
Pounds

Baby Isla was due to be born in July, 2022.
However, mother Lauren went into labor in
March! When Isla was born, she weighed just
1.17 pounds (0.53kg), which is less than a loaf
of bread. Doctors told Lauren that her child had
about a 10% chance of survival. She was so tiny
that her hand looked like a baby doll hand next
to her father’s.

She had some complications due to her early
arrival. Most premature babies have to be on a
ventilator at first, but she also had bleeding in
her brain and a hole in her heart. She was taken
off the ventilator at 6 weeks, but just two weeks
after that, she also had a detached retina in her
eye, which doctors tried to fix but couldn’t.
They waited anxiously to see if she would
survive, and miraculously she got well enough

 Good Words, Good Deeds, Good News

http://www.linuxforum.com
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to go home from the hospital in July. This last
March, they celebrated her first birthday. Now,
she can sit up and is trying to crawl, which is
late for a one year-old, but her parents are very
thankful. Lauren said, "Looking at her now, you
wouldn’t know she was premature. She’s a
proper little madam now, she's got her own
personality, and is the most independent little
girl ever. It's taught us don’t take anything for
granted - we live for each day because you don’t
know what's around the corner.”

Man Mows Neighbors’Lawns For Free

Alex Wells wanted to help people so he started
knocking on doors, asking people if they needed
help. He had a lot of positive responses! Now he
goes to neighbors’ houses, mowing their lawns
and trimming shrubbery for them. He
specializes in taking care of those neighbors

who can’t care for their own yards: the elderly,
those with disabilities, neighbors battling
cancer, single parents, and anyone else who
needs his help.

“I’ll do the ones that haven’t been mowed in like
a month or so but I try to find ones that haven’t
been mowed in several months or sometimes a
year,” he explained.

He has started an Instagram page called “Mow
It Wells” which shows a video of him asking an
elderly lady if he can mow her yard. When she
asks for his price and he says “free” she
excitedly agrees.

“The real excitement comes when I do
something extra. Sometimes I’ll give them a
hundred dollars or I’ll do mulch or plant some
flowers and stuff and that’s when it really gets
special,” he told a news crew.
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by expresso

Editor’s Note: The author of this article
intended to write a whole new tutorial series on
LO. This was his first installment, with more to
come later. However, shortly after finishing this
article, he left for another distro that he thought
better met his needs than PCLinuxOS. That’s
how it is with Linux. Users come, users go. With
his departure, also came his condolences for not
completing his intended article series. We run
his first article here, with hopes that
PCLinuxOS users may benefit from his insights,
views, and knowledge.

This tutorial is about LibreOffice Writer (from
now on referred to as simply Writer). If you
follow along you will learn quite a lot about
how to get stuff done with this amazingly
complex program, which is capable of more
than you might think.

Now, there are some situations in which you
probably do not want to use Writer, like when
you have loads of “objects” in a big document.
Everything other than text is an object. If you
want to work on a document, which you’ll
expect to become large and it is expected to
have a lot of these objects, you’re better off
working with another solution, such as LaTeX.
It’s specifically designed for such situations
(and is a whole other subject of its own).

Let's dive in!

Writer has, by default, quite the ancient looking
interface. Don’t worry, because we have a
selection of several interfaces. If you select
View > User Interface, the following window
will pop up.

In and of itself this window is quite obvious.
The "Apply to Writer" button only applies the
type of GUI to Writer, while "Apply to All"
applies the selected GUI throughout
LibreOffice.

Each of these GUIs are different from the
standard one. Some differ a little, others differ
quite a lot. The window will give a short
description of each GUI. I had, in some cases,
trouble finding his way back to the default GUI.
In those cases I'll explain where you can find the
above window.

First the tabbed GUI. At the top right of the
Writer window, you'll see a little gear. If you

click it, a drop-down menu appears with the
User Interface menu item in it. Clicking it will
yield the above window.

On to Groupbar compact. Over here there's a
dropdown menu on the right side, it's
conveniently called "menu." Clicking this will
display a drop-down menu again, containing the
entry to open the User Interface selection
window.

I'm not going to explain where each feature
hides in each user interface. In this tutorial, I'm
going to assume the default GUI.

In some cases you may find the need to change
the user interface. Don't worry; it's possible,
quite extensively so. Below is an image of the
window you'll find under Tools > customize.

Getting Started With LibreOffice Writer
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All the tabs in this window are dedicated to
allowing you to change Writer to your heart's
content. There's a warning, though: changes that
you make here, can leave you with a Writer
which misses some features and you unable to
fix it, or worse, a Writer which is completely
unusable. So, be careful with what you change
in this window.

Now, let's take a look at the shortcut keys (right
top).

As you can see, Alt+Home and Alt+End have no
function assigned to them. How about we make
them go to the beginning and end of the current
paragraph respectively? For Alt+Home, you'll
need to select the key combination, then the
Category (Navigate, in our case), and finally the
function (To Paragraph Begin). The same can
be done with Alt+End, but then for the function
To Paragraph End.

There's loads more to be discovered in this
window, if you find something that works a bit
clunky, or you miss an option in the menus or
under a shortcut key, all that can be arranged
here.

As you may have noticed, the screenshots of the
windows I showed had a dark theme. In some
cases, you might prefer a different theme than
the default one. I'll explain how to change it
now.

Start off by selecting Tools > Options. In the
window that pops up, select LibreOffice >
View. The window should now look like this:

In this screen, you can choose a light
and a dark appearance of LibreOffice.
I have mine following the system.
Here, you can customize it some
more. Feel free to do so.

You now know how to customize
Writer to your liking.

I hope this tutorial was valuable to
you.

The PCLinuxOS
Magazine

Created with
Scribus

Getting Started With LibreOffice Writer
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by Paul Arnote (parnote)

Most Linux users (PCLinuxOS users included) got their start with
computers using a commercially available OS. Exceptionally few actually
started with Linux.

Along the way, we all encountered software that we came to love. Much of
that software was designed to run on Microsoft Windows, the
commercially available OS that held/holds the lion’s share of the OS
market.

However, as I’m sure we’re all aware, Linux is NOT Windows, and in
MANY aspects, we Linux users are thankful for that. But, it also means
that it’s typically not a trivial task to hang on to and use those software
titles that we came to love along our journey, if we can even get them to
run at all.

To run those cherished programs, we typically have a few choices. One
choice is to dual boot our computer with Linux and Windows. That has
challenges all of its own. This usually means you have to log out of your
Linux account, and reboot your computer into Windows. That can make
sharing data between Linux and Windows a chore, with all sorts of hoops
to jump through (like storing/exporting data output onto a shared drive or a
USB connected drive of some sorts).

Another choice is to run WINE on your Linux computer. While WINE has
gotten progressively better at running Windows programs over the years,
it’s still pretty much a crap-shoot as to whether or not your favorite
Windows program will run under WINE. Some programs are ridiculously
simple to run under WINE, while others are persistently stubborn in their
determination to not run under WINE. There is a commercially available
version of WINE, called CrossOver from CodeWeavers, that tends to run a
bit better. That, though, will set you back $74 (U.S.) annually, which is
nearly the cost of a full-blown version of Windows. For an additional
$420, they’re happy to sell you a “lifetime” version of CrossOver. The
folks at CodeWeavers have, essentially, tweaked and tuned the WINE code
so that it has a better track record of running more Windows programs.

A similar option exists for running old DOS programs. Users can run
DOSBox or some other DOS emulator on the Linux desktop. These DOS
emulators typically do a pretty good job at running DOS programs. This is
probably due to the relative simplicity of DOS, compared to Windows.

Yet another choice is to run an actual copy of Windows in a virtual
machine, such as Virtual Box. Even though this requires you to have an
actual copy of Windows to install as a virtual machine, it allows you to run
a fully functional copy of Windows on your Linux desktop.

Of course, there is one other choice, and it is the one that I’ve made. If
something can’t be done under Linux in its native environment, I’m
typically not interested. I don’t run any of the methods. No dual boot. No

Grab Your Favorite Software From Yesteryear

https://www.codeweavers.com/store
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WINE. No virtual machine. And, no Windows. I don’t feel as if I’m
missing out on anything. In my Linux past, I’ve done each of the other
three methods, all successfully.

Everyone’s needs are different, and each method has their own pitfalls and
challenges. Thankfully, Linux users (as a whole) are pretty resourceful, so
they can usually find a way to resolve the challenges that each approach
presents, along with workarounds to the pitfalls.

I am definitely NOT a “gamer.” Oh, I’ve played some games in my
Windows life, like Wolfenstein, Doom, Descent, and Quake. But that was
years ago. Today, Solitaire is more my speed. And, I was never very good
at the games, anyway. They were just a diversion to fill up my free time
with something enjoyable. Even then, I didn’t have sufficient time to
devote to improving my gameplay. Today, it also probably has something
to do with the fact that I have much less “free time” than I used to. My
“free time” has demands on it by a six and nine year old and all of their
extracurricular activities.

For those users who have loftier “gaming” pursuits, they may employ one
or more of the methods we previously discussed for running their
Windows games. Some may employ all three methods, just to ensure that
they can play their games.

A Software Motherlode

So why talk about how to run Windows on your Linux computer? After
all, aren’t most of us “Windows refugees,” fleeing the tyranny of
Windows?

I’m sure we all have software titles from our past that still bring a smile to
our face. They may be fun to run. Or, they may be satisfying merely for
their familiarity. But whatever the case, most of us have probably
reminisced about playing them again.

Well, you’re in luck.

The Internet Archive has a collection of around 72,000 CD-ROM titles
available for download. Many of them are offered as ISO files, so you can
“burn” them to whatever medium you choose.

Game enthusiasts will be pleased with the collection of CD-ROM based
games available. The image above shows some of the games titles
available. There are many, many more titles available than what I’ve

Grab Your Favorite Software From Yesteryear

https://archive.org/details/cd-roms?tab=collection
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shown here. I just tried to show some of the titles that were extremely
popular in their day, and that most people probably know about.

But the selection doesn’t stop there. In perusing the available titles, I found
almost every version of Windows available. Yes, even including [ew!]
Windows Me, Vista, and Windows 8. I also found old stalwarts, such as
Adobe Photoshop, Adobe Illustrator, multiple Corel titles, educational
software, entertainment software, productivity software, and much more.
Do you remember all those CD-ROMs sold in large chain stores, loaded
with photos and clipart? Well, there’s a great selection of those available,
too.

Keep in mind that much of this software has pretty much been abandoned,
so using it may incur some security risks. Some titles have never been
updated, and others have been superseded by better, more secure versions.
In other words, you will have to use them at your own risk.

Aside from the games, I’m certain that most Linux users can find native-
Linux software that is able to get tasks done. But, if you have a hankering
to reach back in your past and re-experience some of your favorite
software, this is the place where you might find those software titles. But,
be prepared. It may take some time to filter through the nearly 72,000
software titles presented on Internet Archive.

The PCLinuxOS Magazine
Special Editions!

Get Your Free Copies Today!

Grab Your Favorite Software From Yesteryear
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http://www.linuxfoundation.org/
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by CgBoy

Thorium Reader is a free Electron-based
ebook reader designed with accessibility and
ease of use in mind. With support for both
EPUB 2 and EPUB 3, PDF, DAISY, LCP DRM,
and numerous other ebook as well as audiobook
formats, Thorium Reader should be able to open
most books without a problem.

Thorium Reader provides a very uncluttered
interface, making it quick and easy to navigate.
The application is divided into three tabs
allowing access to the main books page, OPDS
catalogs, and the application settings. From the
My Books page, you can open and manage all
your ebooks, which can easily be imported into
Thorium Reader by simply dragging and
dropping them into the application. Books are
automatically sorted into separate categories for
those that were recently added, and those that
you’ve already started reading. You can also add
custom tags to books in order to help organize
them better. A search bar is also provided to
make finding books easier (center, top).

Clicking on a book will open it in a new reader
window, and resume from where you finished
reading last time. As with the main menu, the
layout of the reader screen is clean, simple, and
well designed. At the top of the window is a
toolbar, from which you can return to the main
menu, view information about the current book,

perform searches in the book, add bookmarks,
switch to fullscreen mode, access the reading
settings panel, and access the navigation panel.
From the navigation panel, you can view the
book’s table of contents, go directly to a specific
page number, and access any bookmarks you
may have added. At the bottom of the screen
you’ll find the page navigation buttons, and a
bar showing your progress through the book.

By default, the size and number of text columns
displayed on the page will automatically change
depending on the size of the application
window, but this can be manually adjusted from
the reading settings panel. You can also change
the page view to scrollable, if you prefer
navigating by scrolling. Thorium Reader
provides numerous other reading settings you
can adjust as well, such as text size and font,
letter and word spacing, and several interface

color themes that can be enabled. Thorium
Reader has the option to use text-to-speech to
read aloud books for you, but unfortunately I
could not get this feature to work when I tested
it.

Repo Review: Thorium Reader
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Thorium Reader supports adding OPDS (Open
Publication Distribution System) feeds,
allowing you to easily access large online ebook
catalogs, and import books into the application.
One can, for instance, add the Project Gutenberg
OPDS feed and then be able to quickly find and
read any book available in their collection. This
feature definitely makes Thorium Reader very
useful.

Summary

Thorium Reader provided a very smooth and
distraction-free ebook reading experience, and
was generally quite enjoyable to use. I didn’t
really encounter any real bugs or problems
during my testing of it. Overall, I’d highly
recommend Thorium Reader to anyone looking
for a clean and simple, yet still powerful,
desktop ebook reader.
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Serves: 8

INGREDIENTS:

1 pound lean ground beef
1 large onion diced
4 cloves of garlic minced
28 ounces crushed tomatoes 1 can undrained
15 ounces tomato sauce 1 can
14 ½ ounces petite diced tomatoes 1 can
32 ounces low sodium beef broth
1 red bell pepper diced
1 green bell pepper diced
2 cups sliced mushrooms
2 teaspoons dried basil leaves
2 teaspoons dried parsley
½ teaspoon seasoning salt
½ teaspoon black pepper
6 ounces dried pasta, any shape
2 cups chopped fresh spinach

TOPPINGS:

Mozzarella Cheese
Ricotta Cheese
Parmesan Cheese
Fresh Basil & Parsley

DIRECTIONS:

Cook beef, onion, and garlic over medium-high
heat until no pink remains; drain. Place in a
slow cooker.

Add all remaining soup ingredients except pasta
& spinach. Cover and cook on low 7-8 hours or
high 3-4 hours.

Cook pasta al dente according to package
directions. Stir in cooked pasta and spinach.
Cover and cook for an additional 10-15 minutes.
Spoon into bowls and top as desired.

NUTRITION:

Calories: 257 Carbs: 26g Fiber: 3g
Sodium: 623mg Protein: 18g

PCLinuxOS Recipe Corner Bonus

CrockPot Lasagna Soup
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by Greg Farough
Free Software Foundation
Reprinted under Creative Commons License

Whether it's through the millions of dollars
Google has funneled into development and
advertising or the "convenience" that it offers
users in exchange for freedom, the fact remains
that Google Chrome is the arbiter of web
standards. Firefox, through ethical distributions
like GNU IceCat and Abrowser, can weaken
that stranglehold. Google's deprecation of the
JPEG-XL image format in February in favor of
its own patented AVIF format might not end the
web in the grand scheme of things, but it does

highlight, once again, the disturbing amount of
control it has over the platform generally.

Part of Google's official rationale for the
deprecation is the following line: "There is not
enough interest from the entire ecosystem to
continue experimenting with JPEG-XL." Putting
aside the problematic aspects of the term
"ecosystem," let us remark that it's easy to
gauge the response of the "entire ecosystem"
when you yourself are by far the largest and
most dangerous predator in said "ecosystem." In
relation to Google's overwhelming power, the
average web user might as well be a microbe. In
supposedly gauging what the "ecosystem"
wants, all Google is really doing is asking itself
what Google wants. If we take their contribution
in turning the web into the "WWWorst App
Store" seriously, then we understand what
Google really wants. Google wants to do what's
best for its own predatory interests, not what's
best for the web.

While we can't link to Google's issue tracker
directly because of another freedom issue -- its
use of nonfree JavaScript -- we're told that the
issue regarding JPEG-XL's removal is the
second-most "starred" issue in the history of the
Chromium project, the nominally free basis for
the Google Chrome browser. Chromium users
came out of the woodwork to plead with Google
not to make this decision. It made it anyway, not
bothering to respond to users' concerns. We're
not sure what metric it's using to gauge the

interest of the "entire ecosystem," but it seems
users have given JPEG-XL a strong show of
support. In turn, what users will be given is yet
another facet of the web that Google itself
controls: the AVIF format.

As the response to JPEG-XL's deprecation has
shown, our rallying together and telling Google
we want something isn't liable to get it to
change its mind. It will keep on wanting what it
wants: control; we'll keep on wanting what we
want: freedom.

Google's Decision To Deprecate JPEG-XL Emphasizes
The Need For Browser Choice & Free Formats
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Only, the situation isn't hopeless. At the present
moment, not even Google can stop us from
creating the web communities that we want to
see: pages that don't run huge chunks of
malicious, nonfree code on our computers. We
have the power to choose what we run or do not
run in our browsers. Browsers like GNU IceCat
(and extensions like LibreJS and JShelter) help
with that. Google also can't prevent us from
exploring networks beyond the web like
Gemini. What our community can do is rally
support behind those free browsers that choose
to support JPEG-XL and similar formats, letting
the big G know that even if we're smaller than
it, we won't be bossed around.

Screenshot ShowcaseScreenshot Showcase

Are viruses,
adware, malware &
spyware slowing
you down?

Get your PC back
to good health
TODAY!

Get

Does your computer run slow?

Are you tired of all the "Blue Screens
of Death" computer crashes?

Download your copy today! FREE!

Posted by parnote, May 10, 2023, running Xfce.

Google's Decision To Deprecate JPEG-XL Emphasizes The Need For Browser Choice & Free Formats

http://www.pclinuxos.com/?page_id=10
https://gnu.org/s/librejs
https://jshelter.org/
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SCRAPPLER RULES:
1. Follow the rules of Scrabble®. You can
view them here. You have seven (7) letter
tiles with which to make as long of a word
as you possibly can. Words are based on
the English language. Non-English
language words are NOT allowed.
2. Red letters are scored double points.
Green letters are scored triple points.
3. Add up the score of all the letters that
you used. Unused letters are not scored.
For red or green letters, apply the
multiplier when tallying up your score.
Next, apply any additional scoring
multipliers, such as double or triple word
score.
4. An additional 50 points is added for
using all seven (7) of your tiles in a set to
make your word. You will not necessarily
be able to use all seven (7) of the letters in
your set to form a “legal” word.
5. In case you are having difficulty seeing
the point value on the letter tiles, here is a
list of how they are scored:

0 points: 2 blank tiles
1 point: E, A, I, O, N, R, T, L, S, U
2 points: D, G
3 points: B, C, M, P
4 points: F, H, V, W, Y
5 points: K
8 points: J, X
10 points: Q, Z

6. Optionally, a time limit of 60 minutes
should apply to the game, averaging to 12
minutes per letter tile set.
7. Have fun! It's only a game!

SUDOKU RULES: There is only one valid solution to each
Sudoku puzzle. The only way the puzzle can be considered
solved correctly is when all 81 boxes contain numbers and the
other Sudoku rules have been followed.

When you start a game of Sudoku, some blocks will be prefilled
for you. You cannot change these numbers in the course of the
game.

Each column must contain all of the numbers 1 through 9 and
no two numbers in the same column of a Sudoku puzzle can
be the same. Each row must contain all of the numbers 1
through 9 and no two numbers in the same row of a Sudoku
puzzle can be the same.

Each block must contain all of the numbers 1 through 9 and no
two numbers in the same block of a Sudoku puzzle can be the
same. D
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Possible score 255, average score 179.

PCLinuxOS Puzzled Partitions

https://pclosmag.com/html/Issues/202306/files/2023-06-PuzzleSolutions.pdf
http://www.scrabblesite.com/scrabble/rules/
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AERIAL TRAMWAY BATTLESHIP

BOBSLED BULLDOZER

CATAMARAN DIRIGIBLE

DUGOUT CANOE EIGHTEEN WHEELER

FORKLIFT GONDOLA

HANG GLIDER HOVERCRAFT

HUMVEE KAYAK

LOCOMOTIVE MONORAIL

MOPED PADDLEWHEELER

RICKSHAW RIVERBOAT

SEAPLANE SEGWAY

SNOWMOBILE SPACESHIP

SPEEDBOAT STAGECOACH

STEAMSHIP SUBMARINE

THRESHER TOBOGGAN

TRAWLER TUGBOAT

UMIAK UNICYCLE

VESPA WHEELBARROW

YACHT ZAMBONI

ZEPPELIN

Download Puzzle Solutions Here

W K O T U J E X S P C Y J U N K A I M U J G H K T G M S W S
M M H T N W Q L B Z Q J F O E U N X S B Y L N T K J S Z Y P
Q O U T D T T O A B L O B E Y F N B Y W I Q S E A P L A N E
R X N K H T E M T L C F O I L A Z I E N D M L J I V D D L E
J P U O R N B R I V E R B O A T W I L T B B F A Y E R J E D
J M P I R O R V F V S K F Z U F Z M G E I U A C F L H Y D B
J H W Y N A E U T E A J R T T Y L Z A G P P I G V C U M Y O
B P F I S D I Q S F W K M U O R V Q I R N P W F K Y M R I A
A D I A P Q G L U N Y C A T A M A R A N T A E O Q C V F X T
A O X L P G H C A O C E G A T S I W R K L L G Z F I E T K E
Q O Y J Q S T C X V J T L U P D V W L X Y U A G U N E X M E
T F A R C R E V O H B W F I A X J Y R E G X L I O U O O Q N
O U W V G K E V L L Q K B U L L D O Z E R R B T R B P X T I
E K G S N C N N A K T B O S O H T A Q I U T W I C E O B J R
C F E P R F W E S R C M B W D L Y K T R K V O H D X A T G A
A Y S D K L H B E Y I I S P N O S P A C E S H I P I S T Z M
P E Z A I P E U B W B G L N O C P C F O R K L I F T P U H B
N Q A E C A E K A Y A K E I G O K T T R L R O Y E L M G W U
K Z M L L D L Q V B X D D S U M L F V O U J L A A M C B H S
Y W B I A D E A A H A K Y H H O J C P Z F K M C L C D O E U
V Z K B L L R Z H N X T P S F T V B Q P L S M S O X H A E R
S Y E O L E J D J S K W T S F I M V S C H T Z K A O F T L Z
F M B M Q W Q E W P L L P L A V A Z L I U C H W M D P A B K
C F S W S H O T M U S U G A E E D H P L I C I R P G B K A P
X V U O J E U O V Z V R I C K S H A W O G T M U E O H U R F
K A Z N E E A F Q V N K E N Q M H V F G I S V O L S Y V R Y
G K Y S X L X L O Z K A U G E S J I F E D R C T N N H E O L
B Q I O E E D W G D E C B N V H I T P Y J H W B Y M G E W J
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PCLinuxOS Puzzled Partitions

June 2023 Word Find
Modes of Transportation

https://pclosmag.com/html/Issues/202306/files/2023-06-PuzzleSolutions.pdf
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1. A rail-based transportation system based on a single
rail, which acts as its sole support and its guideway.

2. A lightweight narrow barge with ends that curve up
into a point, propelled with a single oar.

3. A trademark for a durable wide-bodied military
vehicle with four-wheel drive.

4. A brand name for an electric vehicle with two
wheels.

5. A brand of machine that smooths the surface of the
ice on a rink.

6. A large boat that uses a wide, cone-shaped net to
catch fish.

7. A boat with two parallel hulls or floats, with a mast
mounted on a transverse frame joining the hulls.

8. A small two-wheeled cart for one passenger; pulled
by one person

9. An Italian luxury brand of scooters and mopeds.
10. A large, open boat made of skins stretched over a

wooden frame that is propelled by paddles.
11. A four-wheeled horse-drawn vehicle used to

transport mail and passengers over a regular route.
12. A rigid airship having a long cylindrical body

supported by internal gas cells.
13. A farm machine for separating small grain and

seed crops from their chaff and straw.
14. A heavy machine for clearing and grading land,

having continuous treads and a hydraulic blade
in front.

Download Puzzle Solutions Here

PCLinuxOS Puzzled Partitions

June 2023 Crossword
Modes of Transportation

https://pclosmag.com/html/Issues/202306/files/2023-06-PuzzleSolutions.pdf
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Download Puzzle Solutions Here

PCLinuxOS Puzzled Partitions

Mixed-Up-Meme Scrambler

https://pclosmag.com/html/Issues/202306/files/2023-06-PuzzleSolutions.pdf
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Posted by Meemaw, May 11, 2023, running Xfce. Posted by astronaut, May 3, 2023, running Openbox.

Posted by tuxlink, May 1, 2023, running KDE. Posted by luikki, May 1, 2023, running KDE.

More Screenshot Showcase




